CHAPTER V

ECGSIM PROGRAM FOR QRS SIMULATION

5.1 INTRODUCTION

ECGSIM is an interactive simulation program [95] that enables to study the relationship between the electric sources of the ventricular myocardium and the resulting potentials on the thorax (QRST waveforms as well as body surface potential maps) [96] and on the heart surface (electrograms, potential maps, and maps of the local transmembrane potential). Both the depolarization [103,104,105] and the repolarization phase are covered, but not the electric activity of the atria.

One of the objectives for ECGSIM is to serve as a research tool for those interested in testing any hypothesis they may have regarding the manifestation of cardiac malfunctioning in the electrocardiographic waveforms on the thorax [105].

Another objective is for it to serve as an educational tool, to be used for students learning the basic aspects of the genesis of the electrocardiogram.

ECGSIM is not a diagnostic tool. Any diagnostic application is only indirect; ECGSIM provides a forward simulation and does not solve the inverse problem.

5.2 ECGSIM CONTENTS

1. Introduction
2. Basic Usage
3. File
4. Heart
5. Thorax
6. Membrane
7. ECGs
8. Movie
9. Help
10. Alternative Geometry
5.3 ECGSIM ALGORITHMS

ECGSIM simulates electrocardiographic potentials [106] by specifying the distribution of the timing of depolarization, dep(n), and repolarization, rep(n), of the transmembrane potentials at nodes n, (n=1...N), where N is the number of nodes at the surface bounding the ventricles, referred to henceforth as the heart surface. For every node the difference apd(n)=rep(n)-dep(n) is taken a measure of the local action potential duration. The ventricular surface is the closed surface bounding all ventricular mass, i.e.,
endocardium, epicardium and their connection at the base of the ventricles. The magnitude of the upstroke of the local transmembrane potential, \( \text{str}(n) \), representing the local source strength, is allowed to be non-uniform. By setting pre-computed values for the parameters \( \text{dep}(n) \) and \( \text{rep}(n) \) for each node and using a uniform \( \text{str}(n) \) values, potentials are simulated that closely resemble the set of reference values recorded on a healthy subject.

The program allows the interactive changing of the local timing of depolarization and repolarization as well as the magnitude of the upstroke of the local transmembrane potentials. The former two sets of parameters allows to study the effect of changes in local timing, the latter set, the manifestation of local ischaemic regions.

The strength of the cardiac equivalent generator involved is the distribution on the heart surface \([24,26]\) of the local transmembrane potential. The transfer used to determine the expression of these sources as body surface potentials was computed by applying the laws of current flow to an inhomogeneous torso model.

### 5.4 BASIC USAGE OF ECGSIM WINDOW

The interactive operation of ECGSIM is almost entirely mouse controlled. The main mouse operations are: dragging (moving the mouse while holding the mouse button down) and clicking of either the left- or the right mouse button.

The ECGSIM main window consists of four panes: the heart pane, the thorax pane, the membrane pane and the ECGs pane. Refer figure 5.1 for ECGSIM window. The boundaries between the planes may be shifted by using the left mouse button (drag). For each pane there is a menu item on the menu bar. The options in each menu control is displayed in the corresponding pane.

The most frequently used functions are also available from the tool buttons at the top of each pane. To view the function of each button, rest the mouse cursor on the button without pressing any of the mouse buttons. A short text explaining the function of the button will appear.

The heart and the thorax can be rotated by left mouse button dragging or by rotating the mouse wheel. The default, frontal, view is restored by clicking on the reset orientation button on the tool bar.
By clicking with the right mouse button on the heart surface in the heart plane, the nearest of the N nodes will be selected. The membrane pane shows the transmembrane potential at this node. By means of the sliders (left mouse button drag) in this pane, the parameters: onset (dep), duration (dur) and source magnitude (str) at that node and a region around it can be changed. The resulting changes are visible in the heart pane if the corresponding surface function has been selected.

The effect of these changes on the body surface potentials may be viewed in the ECGs pane and the thorax pane.

The status bar at the bottom of each pane shows properties of what is being displayed in that pane.

5.4.1 FILE

The File menu has the following entries:

- Open;
- Save;
- Default;
- Print;
- Exit.

Open

The Open menu item starts up a sub-menu containing two entries: Source parameters and Reference surface potentials..

Open: Source parameters

The parameters ECGSIM works with are: depolarization times, dep, repolarization times, rep, and the magnitudes of the local transmembrane potential, str, at all nodes of the heart. Open -> Source parameters allows the user to replace the default parameter by those read from a file. A file saved during a previous ECGSIM session, can be opened or a new can be created.
If the source parameters loaded from a file contain depolarization times beyond 500 ms, the maximum repolarisation time is automatically set to 1000 ms.

Open: **Reference surface potentials**

Open -> Reference surface potentials allows to replace the default set of reference potentials. These will be used both for the reference body surface potentials in the thorax pane and the reference 12-lead ECG in the ECGs pane. A file saved during a previous ECGSIM session, can be opened or a new can be created.

The number of rows in the file must match the number of nodes on the thorax. Reference surface potentials may also be loaded when ECGSIM starts by using the `-ref` command line option.

Save

The Save menu item starts up a sub-menu containing three entries:, Source parameters, simulated surface potentials, and simulated 12 lead ECG.

Save: **Source parameters**

The set of depolarization times, dep, repolarization times, rep, and transmembrane potential magnitudes (str) at all nodes of the heart can be saved to a file by using Save -> Source parameters.

Save: **Simulated surface potentials**

Save -> Simulated surface potentials allows the user to save the simulated surface potentials at all nodes of the thorax to a file. These may later be opened to serve as reference potentials, or used for further analysis outside ECGSIM.

Save: **Simulated 12-lead ECG**

Save -> Simulated 12-lead ECG allows the user to save the simulated 12-lead ECG to a file. These may then be saved for further analysis outside ECGSIM.

Default

Once a source description file is opened, the default set of source parameters is lost. You may restore the default source parameters by choosing Default can be restored.
Print

The Print menu item starts up a sub-menu, from which it can be chosen which pane is to be printed.

ECGSIM sends a bitmap copy of the pane to the printer, hence the resolution of the print-out is that of the screen and not that of the printer (which commonly has a much higher resolution).

5.4.2 FILE FORMATS

File format explain the source description files, surface potential files and 12 lead ECGs file

Source description files

The default extension of the files in which ECGSIM stores the source parameters is .src. The format of the file is:

\[
\begin{align*}
N & = 3 \\
d(1) & = r(1) = s(1) \\
d(2) & = r(2) = s(2) \\
\vdots \\
\vdots \\
d(N) & = r(N) = s(N)
\end{align*}
\]

where \(N\) is the number of rows that follow (=the number of nodes at the heart; \(N=257\) for the default heart geometry), 3 is the number of columns, \(d(n)\) is the depolarization time at node \(n\) in ms, \(r(n)\) is the repolarization time at node \(n\) in ms, and \(s(n)\) is the depolarization magnitude at node \(n\). The scaling of the latter ranges from a value of 0 for inactive nodes to 1 for the full (relative) magnitude of the upstroke of the transmembrane potential.

The index \(n\) of a selected heart node may be displayed on the status bar of the heart pane by displaying the geometry in that pane and selecting the node.
Surface potential files

The default extension of the files in which ECGSIM stores surface potentials is .bsm.

The format of the file is the standard format used for matrix files in ECGSIM:

L
T
p(1,1) p(1,2) ... p(1,T)
p(2,1) p(2,2) ... p(2,T)
...
...
p(L,1) p(L,2) ... p(L,T)

where L is the number of rows that follow (=the number of nodes on the thorax; L=300 for the default torso geometry), T is the number of columns (=number of time samples) and p(l,t) is the potential in mV at node l at sampling time t.

The sample frequency is 1000 Hz

The index of the selected thorax node may be displayed on the status bar of the thorax pane by displaying the geometry in that pane and selecting the node.

12-lead ECG files

The default extension of the files in which ECGSIM stores 12-lead ECGs is .ecg. The format of the file is:

L T
p(1,1) p(1,2) ... p(1,T)
p(2,1) p(2,2) ... p(2,T)
\( p(L,1) \ p(L,2) \ \ldots \ p(L,T) \)

where \( L \) is the number of rows that follow (=the number of leads, normally 12), \( T \) is the number of columns (=number of time samples) and \( p(l,t) \) is the potential in mV at lead \( l \) at time sample \( t \).

Rows 1-6 correspond to leads V1-V6, rows 7-9 to leads aVR, aVL and aVF, respectively and rows 10-12 to leads I, II and III, respectively.

The implied sample frequency is 1000 Hz.

**Triangulated geometry files**

The format of the files that describe triangulated geometries is as follows:

```
npn
t
1 \ x(1) \ y(1) \ z(1)
2 \ x(2) \ y(2) \ z(2)
```

```
\ldots \ \ldots \ \ldots
```

```
npnt \ x(npnt) \ y(npnt) \ z(npnt)
ntri
1 \ ind(1,1) \ ind(1,2) \ ind(1,3)
2 \ ind(2,1) \ ind(2,2) \ ind(2,3)
```

\ldots
ntri ind(ntri,1) ind(ntri,2) ind(ntri,3)

where npnt is the number of vertices, x(i), y(i) and z(i) are the coordinates (in meters) of vertex i, ntri is the number of triangles, and ind (j,1), ind(j,2) and ind(j,3) are the indices of the vertices of triangle j. The order of the indices for a triangle defines the orientation of the triangle; when viewed from the outside the vertices are numbered clockwise.

5.5 HEART PANE

The heart pane is used to display the geometry of the heart and any of a wide range of functions on its surface. If a node on the heart is selected by right a mouse button click, its position is shown by a black patch. Refer Figure 4.24 for the Heart Pane.

Fig. 5.2 : The Heart Pane

The function that is being displayed in the heart pane, as well as various display options that can be selected from the Heart entry on the menu bar:

- Surface function;
Display options;
Scale;
Orientation.

Mouse actions in the heart pane are reflected in this pane and may also have an effect on the other ones.

The image shown in the heart pane may be copied to the clipboard by selecting Copy from the Heart menu, or by pressing Ctrl-C while the mouse is within the heart pane.

5.5.1 SURFACE FUNCTION

The item Surface function in the heart menu brings up a dialog window, with which you may choose the function to be displayed on the heart surface. Options available are: the depolarization times, repolarization times, action potential duration, action potential magnitude, transmembrane potential, epicardial potential and the transfer function.

The most frequently used surface functions may also be activated by clicking on the corresponding button on the tool bar at the top of the heart pane.

If transmembrane or epicardial potentials are displayed, the status bar indicates the time instant for which the potentials are displayed. The up and down arrow keys can be pressed to in- and decrease time by steps of one millisecond. Use the page up and page down keys for in- and decrements with steps of ten milliseconds. It can be clicked in the membrane and ECGs pane on the time instant for which the potentials are required to be displayed. Finally, the movie option is used to view the development in time of the potentials as a movie.

5.5.2 DISPLAY OPTIONS

The item Display options in the Heart menu brings up a dialog window in which it is chosen how the heart and the surface function are to be displayed. There are two tabs: the Geometry tab that controls the geometry options, and the Surface function tab that controls the surface function options.
Display options: Geometry

To facilitate orientation, the left arteria descendens marking the boundary between
the right and left ventricle may be brought into view. In addition, the precordial thoracic
electrodes may be included in the display. In the geometry tab, it can be selected whether
the electrodes to be shown, and whether the electrodes should be transparent or opaque.

It can be chosen whether the size of the range around the selected node that is affected by
changes of the source parameters at the selected node should be shown on the heart
surface. It can be chosen to display the outline of the range, to dim the region of the heart
surface that is within the range, or to dim the region outside the range. The heart surface
may be hidden or made transparent. If a function is mapped on the heart surface using a
color code, the surface will always be opaque, since a colored transparent heart is too
confusing. To map a function on the heart while being able to Refer through the surface,
use isofunction lines only.

The heart vector and vector loop (according to the Frank leads) for the simulated
data may be displayed by choosing opaque for the corresponding items. The scale of the
vector is 13 cm/mV times the scale factor of the signals in theECGs pane. The size of the
displayed vector can be changed by using the scale in the ECGs pane.

Display options: Surface function

The surface function tab allows to determine how the function is displayed; by a
color map, isofunction lines, or by both. Also, it is determined whether the light effect
should be active when using a color map display. The light effect gives a three-
dimensional impression of the geometry of the heart, but it also renders the colors on the
surface less bright.

5.5.3 SCALE

The item Scale in the heart menu brings up a dialog window, through which the
scale can be set for the various surface functions that are plotted on the heart surface.

By default, the scale of time functions (repolarization, depolarization and action potential
duration) is adapted automatically as the timing values change. By unchecking the
Autoscale check box, manual control by means of the three timing sliders is enabled.
5.5.4 MOUSE ACTIONS IN THE HEART PANE

Orientation

The heart can be rotated by (left) mouse dragging. By rotating the mouse wheel, the heart rotates along an axis perpendicular to the screen. If the shift key is pressed simultaneously, the angle by which the heart rotates with each click of the mouse wheel becomes smaller.

Selection

A node at the heart is selected by a right mouse button click on the heart surface. The node nearest to the "click" is selected, as shown by a black patch on the surface. Only one node may be selected at a time; if another node is selected, the previous one is deselected. If the right mouse button is clicked outside the heart, the currently selected node is deselected.

If a function is mapped on the heart surface, the value at the selected node is displayed on the status bar of the heart pane. If the geometry is displayed, the location of the selected node and its index are displayed (the node index corresponds to the row in which the source parameters for that node are saved).

In the membrane pane the transmembrane potential of the selected node is displayed.

Setting the range

The size of the range around the selected node that is affected by changes of the source parameters at the selected node may be set by clicking the middle mouse button. The point that was clicked on will define the edge of the selected range.

The size of the range may also be set from the range dialog window in the membrane menu. In this dialog window it may also be chosen whether the range should be computed through the myocardium (transmurally), or merely on the part of the heart surface that carries the selected node.

5.6 THORAX PANE

The thorax pane is used to display the geometry of the thorax, and any of a wide range of functions on the thorax surface. If a node on the thorax is selected, it is shown by a black patch on the surface.
What exactly is displayed in the thorax pane and how, is controlled by the various menu options available from the Thorax entry on the menu bar:

- Surface function;
- Display options;
- scale;
- orientation.

Mouse actions in the thorax pane are reflected in this pane and may also have an effect on the other ones.

The contents of the thorax pane is copied onto the clipboard by selecting Copy from the Thorax menu, or by pressing Ctrl-C while the mouse is within the thorax pane.

5.6.1 SURFACE FUNCTION

The item Surface function in the thorax menu brings up a dialog window, with which the function to be displayed is chosen on the thorax surface. Available are the simulated potentials (i.e. the potentials that result from the transmembrane potentials at the heart as set by the user), the reference (i.e. measured) potentials, and the transfer function.

The most frequently used surface functions may also be activated by clicking on the corresponding button on the tool bar at the top of the thorax pane.

If surface potentials are displayed in the thorax pane, the status bar indicates the time instant for which the potentials are displayed. The up and down arrow keys can be pressed to increase and decrease the time by steps of milliseconds. The page up and page down keys are used for increments with steps of ten milliseconds. Also, in the membrane or in the ECGs pane can be clicked to select the time instant for which the potentials are required to be displayed. Finally, the movie option is used to view the development of the potentials in time as a movie.

5.6.2 DISPLAY OPTIONS

The item Display options in the Thorax menu brings up a dialog window, from which it is selected how the thorax and the surface function are displayed. There are two
tabs: the Geometry tab that controls the geometry options, and the surface function tab that controls the surface function options.

Display options: Geometry

In the Geometry tab it is determined whether the heart, lungs, thorax and precordial electrodes is to be displayed, and whether it is required to be transparent or opaque.

If a function is mapped on the thorax using a color code, the surface will always remain opaque, as a colored transparent thorax is too confusing. To map a function on the thorax while being able to Refer through the surface, isofunction lines only are used.

The heart vector and vector loop (according to the Frank Leads) for the simulated data may be displayed by choosing opaque for the corresponding items. The scale of the vector is 20 cm/mV times the scale factor of the signals in the ECGs pane. The size of the displayed vector is changed by changing the scale in the ECGs pane.

Also, it can be chosen whether the grid and/or the nodes that make up the discretized thorax are to be displayed.

Display options: Surface function

The surface function tab allows to determine how the function is displayed; by a color map, isofunction lines, or both. Also, it is determined whether the light effect should be active when using a color map display. The light effect gives a three-dimensional impression of the geometry of the thorax, but it also renders the colors on the surface less bright.

5.6.3 SCALE

The item Scale in the thorax menu brings up a dialog window, by which the scale for the various surface functions that can be plotted on the thorax surface is set. This dialog window may also be started by clicking on the Scale button on the thorax tool bar.
5.6.4 MOUSE ACTIONS IN THE THORAX PANE

Orientation

The thorax can be rotated by left-mouse dragging, i.e. move the mouse while holding the left mouse button down. By rotating the mouse wheel, the thorax rotates along an axis perpendicular to the screen. If the shift key is pressed simultaneously, the angle by which the thorax rotates with each click of the mouse wheel becomes smaller.

Selection

A node at the thorax is selected by clicking with the right mouse button on the thorax surface. The node nearest to the "click" is selected, as shown by a black patch on the surface. Only one node may be selected at a time. If another node is selected, the previous one is deselected. If the right mouse button is clicked outside the thorax, the currently selected node is deselected.

If a function is mapped on the thorax surface, the value at the selected node is displayed on the status bar of the thorax pane. If the geometry is displayed, the index of the selected node is displayed (the node index corresponds to the row in which the surface potentials for that node are saved).

In the ECGs pane, it can be chosen to display just the (single) ECG at the selected node.

5.7 MEMBRANE PANE

The membrane pane displays the transmembrane potential at the selected node of the heart surface. If desired, the electrogram at that node may also be displayed. Refer Figure 5.3 for Membrane Pane.

The sliders allow to change the parameters describing the transmembrane potential: the depolarization time (the fast onset of the action potential), the repolarization time (defined as the moment of maximum down-slope during repolarization), and the magnitude of the action potential. The action potential duration that results is taken to be the difference between the specified repolarization and depolarization times.
**Fig. 5.3: The Membrane Pane**

The left knob of the slider pair beneath the plot allows to specify the onset (dep) of the action potential at the selected node. The right knob affects the depolarization time (rep). When the left slider knob is moved the right one moves along. In this way the action potential duration (apd) remains constant. Moving the right knob sets the repolarization timing (rep) only. This also affects the duration since \( rep = dep + apd \). The numbers shown indicate (from left to right): dep, apd and rep.

The slider on the right is used to change the action potential magnitude, expressed as a fraction of its normal value.

If the user changes the source parameters, the effect on the ECG is immediately visible in the other panes, provided that the appropriate functions have been selected.

The Membrane menu on the menu bar contains the following entries:

- undo;
- undo all;
- show electrogram;
- Focus;
- Range;
- Maximum repolarisation time;
- statistics;
- Repolarisation waveform.

The image shown in the membrane pane may be copied to the clipboard by selecting Copy from the Membrane menu, or by pressing Ctrl-C while the mouse is within the membrane pane.

FOCUS

If Focus from the Membrane menu is chosen, the currently selected node on the heart surface will be a focus of depolarization. A dialog window will appear that allows to control the parameters (e.g. propagation velocity) of the depolarization wave front starting from this focus.

In this dialog window, the depolarization time of the focus can be set, and the speed of the depolarization wave front started from this focus. Furthermore it is chosen whether the selected node should be the only focus of depolarization (Replace current activation sequence), or whether the node should be an additional focus (Add to current activation sequence). In the latter case the original depolarization times will be retained for nodes that are reached by the new depolarization wave front at a later time than its original depolarization time.

If a focus of depolarization is defined on the heart surface, the repolarization time \( \text{rep}(n) \) of each node \( n \) is set as follows:

\[
\text{rep}(n) = \text{dep}(n) + \text{OldDur}(n) + 0.4 \left( \text{OldDep}(n) - \text{OldMeanDep} \right) - 0.4 \left( \text{dep}(n) - \text{MeanDep} \right),
\]

where \( \text{OldDur}(n) \) is the original action potential duration of node \( n \) (i.e. before the focus was defined), \( \text{OldDep}(n) \) is the original depolarization time of node \( n \), and \( \text{MeanDep} \) and \( \text{OldMeanDep} \) are, respectively, the new and original mean depolarization times.

This, heuristic, assignment of repolarization times is based on the following arguments. The original distribution of the action potential duration is partially an expression of the intrinsic characteristics of the myocardium. For another part it is the result of the distribution of the activation times, where regions that depolarize early tend to repolarize late. Hence the new action potential duration is set the original one, plus a
term that is negative is the new activation time is later than before, and vice versa. The weight factor 0.4 is based on the statistical relation between depolarization and repolarization times.

**RANGE**

The parameter values of nodes within a certain range around the selected node are also adapted. The relative amount by which these node values change changes from one at the selected node to zero at the edge of the range.

The size of the range is controlled by the range dialog window, which may be activated from the membrane menu. In this dialog window it is also chosen whether it is required to compute the range through the myocardium, or along the myocardial surface. In this way various myocardial malfunctions may be modeled. For instance, a bundle branch block would affect both epicardium and endocardium in roughly the same way. So here the range is chosen through the myocardium. On the other hand, hypertrophy, may be modeled by increasing the activation times at the epicardium only. In such cases it is desired to restrict the range to the epicardial surface.

As an alternative, the size of the range is also set by clicking with the middle mouse button on the heart surface displayed in the heart pane. If some parameter(s) of the selected node are changed, and subsequently the range is changed, the changes will be recomputed for the new range. If it is required to make new changes on top of the old ones for a different range, first select another node and then come back to this node.

**UNDO**

Recent changes may be undone by selecting Undo from the Membrane menu, or by clicking on the Undo tool button on the tool bar at the top of the membrane pane.

By selecting Undo All, or clicking on the Undo All tool button, all changes made since the start of the program or since the last time a source parameters file was opened are undone. Once a source parameter file is opened, one can go back to the default source parameters (i.e. the ones with which the program starts) by selecting Default from the File menu.
SHOW ELECTROGRAM

This option is used in the membrane menu to show and hide the electrogram at the selected node on the heart surface.

MAXIMUM REPOLARIZATION TIME

By default, the maximum value for the repolarization time of any node is 500 ms. This is adequate for most cases, but in some cases, e.g. the simulation of the long QT syndrome, later depolarization times are needed.

By selecting Maximum repolarization time from the Membrane menu, a dialog window is opened that allows to choose between the values 500 ms and 1000 ms for the maximum repolarization time. All sliders involving depolarization time or action potential duration are adapted to the selected maximum repolarization time.

When reducing the maximum repolarization time from 1000 ms to 500 ms, there may be nodes that have a repolarization time beyond the new maximum. If such is the case, the user is prompted to consider whether these values should be clipped to 500 ms.

If a source parameter set loaded from file contains repolarization times beyond 500 ms, the maximum repolarization time is automatically set to 1000 ms.

STATISTICS

By selecting the Statistics item from the Membrane menu, a dialog window is opened that displays information about some basic statistics of the timing parameters. In addition it allows the user to scale these statistics. This is effected by merely scaling and/or shifting the involved source parameters, while keeping the pattern of their distribution in tact.

The dialog window contains a table that displays the mean, standard deviation, minimum, and maximum of the depolarization times, repolarization times, and action potential durations.

The dialog window also contains sliders to scale the means and dispersions (standard deviations) of these timing parameters. The result of these changes are
immediately visible in the various panes. While this dialog window is being displayed, all controls outside the dialog window are inactive.

The size of the sliders and slider knobs are automatically adjusted to ensure that no non-valid values of the timing parameters are generated (i.e. depolarization before 0 ms, repolarization beyond 500 ms, or action potential duration less than 50 ms). Also, scaling of the depolarization dispersion will lead to changes in the action potential duration dispersion and vice versa.

**REPOLARIZATION WAVEFORM**

When ECGSIM starts, the overall waveform of the repolarization is computed by integrating and averaging the T-wave of the reference ECG, as described in, Genesis of the t wave based on an Equivalent surface maodel listed in the reference section. Subsequently, this waveform is adapted to fit the depolarization and repolarization time of each node at the heart.

By selecting the Repolarization waveform item from the Membrane menu, the overall waveform is recomputed from the dominant T wave estimated from the current reference ECG. Furthermore, a dialog window appears containing a slider by which the steepness of the down slope may be changed, as percentage of the slope that was computed from the reference ECG.

**TIME INSTANT SELECTION**

If surface potentials are displayed in the heart or thorax panes, a vertical yellow line in the membrane pane indicates the time instant for which the potentials are displayed. If the left mouse button is clicked on within the membrane pane, the potentials for the corresponding time instant are displayed in the thorax pane. The up and down arrow keys are pressed to in- and decrease the time by steps of milliseconds, and the page up and page down keys for in- and decrements with steps of ten milliseconds.

### 5.8 ECGs Pane

The ECGs pane displays ECGs. Refer figure 5.4 for ECGs Pane.
DISPLAY PROPERTIES

The Display properties dialog window is activated from the ECGs menu. It allows to select which ECGs are required to display: the simulated ECGs (i.e. those that result from the transmembrane potentials at the heart as set by the user), the reference (i.e. measured) ECGs, or both. The simulated ECGs are shown in red, the simulated ones in blue. It may be chosen which ECGs are required to display by pressing the corresponding tool buttons on the ECGs tool bar.

In the Display properties dialog window it may also be chosen whether it is desired to display the standard 12-lead ECG, the ECG at the node selected in the thorax pane, or the vectorcardiogram (VCG) according to the Frank lead system.

SCALE

In the scale dialog window, also activated from the ECGs menu, the vertical scale can be set and selected the time span required to display. The scale dialog window can be activated by pressing the scale tool button on the ECGs tool bar.
FILTERING

In the filtering dialog window, activated from the ECGs menu as well, the type of temporal filtering applied to the simulated ECGs can be chosen. This also affects the simulated ECGs in the thorax pane.

If baseline correction (the default value) is chosen, the potentials at the beginning of the P wave and at the termination of the T wave will have zero potential. This is how idealized ECGs are commonly presented. If AC filtering (the standard type of filtering in ECG recorders) is chosen, the average of the potential over time will be zero for all leads. If DC filtering is chosen, the ECGs are in fact unfiltered, i.e. the true potentials are plotted.

At the body surface, no DC recording of the ECG is possible, due to the contact potentials between the skin and the electrodes. These contact potentials slowly vary in time and have magnitudes that are generally much greater than that of the ECG. The AC-coupling that is always involved in ECG recordings effectively reduces the effect of these contact potentials. However, AC-coupling also wipes out any DC component that may be generated by the heart's electric activity. This component can never be recovered. The baseline correction that is commonly involved in the analysis of the ECG tries to overcome this problem, but is only successful if no currents are generated by the heart in the interval between successive beats.

The DC option in ECGSIM allows one to study the effect of the AC and baseline coupling of ECG amplifiers. The DC filtered (unfiltered) ECGs are referred to differ from the baseline corrected ECGs if of regions of reduced action potential amplitude (ischemia) are present. Where in baseline corrected ECGs ischemia leads to ST elevation, the actual (DC) potentials would lead to the depression of the baseline, and vise versa. If the ST segment is much shorter than the TP interval, AC filtering results in a TP interval that is close to zero, and hence ECG recordings may look more like baseline corrected ECGs than do unfiltered ECGs.

RELATION WITH OTHER PANES

If surface potentials are displayed in the heart or thorax panes, a vertical yellow line visible in the plots indicates the time instant for which the potentials are displayed. If
the left mouse button is clicked on within the ECGs pane, the potentials for the corresponding time instant are displayed in the thorax pane. The up and down arrow keys are also pressed to in- and decrease the time by steps of milliseconds, and the page up and page down keys for in- and decrements with steps of ten milliseconds.

The temporal filtering of the simulated ECGs in the thorax pane and those in the ECGs pane are both controlled by the values set in the filtering option of the ECGs menu.

COPYING THE CONTENT OF THE ECGS PANE

The contents of the ECGs pane may be copied to the clipboard by selecting Copy from the ECGs menu, or by pressing Ctrl-C while the mouse is within the ECGs pane.

5.9 MOVIE

If surface potentials are displayed in the heart or torax panes, one can start up a movie in which the surface potentials are shown for subsequent time instances. During the movie vertical yellow lines in the membrane and ECGs panes indicate the time instant for which the potentials are displayed.

The movie can be started by selecting Start from the movie menu. It can also be started by clicking on the Start/stop movie tool button in the thorax pane.

MOVIE PROPERTIES

The movie parameters are controlled from the Movie properties dialog window, which is activated from the Movie menu.

By default, the start and end of the movie coincide with the first and last time instant shown in the ECGs pane. By unchecking the Lock to ECG span, the Start/end slider in the Movie properties is enabled, and may be used to set the span of the movie.

The speed slider controls the movie speed, which may be varied from 10 ms/s to 1000 ms/s (i.e. real time).

5.10 HELP

There are 4 ways to obtain help in ECGSIM:

1. For a comprehensive manual, choose Manual from the Help menu. This way one will start the built-in manual browser. While the manual browser is active, may
ECGSIM can be continued to operate, enabling one to experiment while consulting the manual. The manual browser is locked while a dialog window is activated.

2. If one choose What's this? from the Help menu, the mouse pointer changes into a question mark. The mouse cursor can be moved to the object within ECGSIM about which it is desired to know more, and then click on the left mouse button. A brief text with an explanation of the object's function will appear.

3. The function of the tool buttons are determined at the top of each pane by resting the mouse above them for a moment. A brief text with an explanation of the function of the button will appear.

4. The dialog windows in ECGSIM contain a button with a question mark in the title bar. If this button is pressed, the mouse cursor changes into a question mark. If one clicks on an element of the dialog window, a brief text with an explanation of the function of the element will appear.

5.11 ALTERNATIVE GEOMETRY

The default (heart and torso) geometry set built into ECGSIM can be replaced by a set constructed by anybody. Then it is required to supply the corresponding transfer function, the distance matrices used to compute along the heart surface or through the myocardium. This section of the manual describes how to incorporate alternative geometry data into ECGSIM, and the formats of the files involved.

LOADING ALTERNATIVE GEOMETRY DATA INTO ECGSIM

In order to load the alternative geometry data in ECGSIM, the file names in the command line must be specified by starting ECGSIM in the following way:

```
```

with

```
file format description
```

file format description
<table>
<thead>
<tr>
<th>File Name</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TransferFile</td>
<td>matrix</td>
<td>contains the MCG transfer matrix</td>
</tr>
<tr>
<td>SourceFile</td>
<td>matrix</td>
<td>contains initial source parameters</td>
</tr>
<tr>
<td>heartFile</td>
<td>geometry</td>
<td>contains the triangulated heart</td>
</tr>
<tr>
<td>SurfDistFile</td>
<td>matrix</td>
<td>contains the distance between nodes at the heart measured along the surface of the myocardium</td>
</tr>
<tr>
<td>VolDistFile</td>
<td>matrix</td>
<td>contains the distance between nodes at the heart measured through the myocardium</td>
</tr>
<tr>
<td>ThoraxFile</td>
<td>geometry</td>
<td>contains the triangulated torso</td>
</tr>
<tr>
<td>StdLeadsFile</td>
<td>Refer</td>
<td>contains below</td>
</tr>
<tr>
<td>LungsFile</td>
<td>geometry</td>
<td>contains the triangulated lungs (may be omitted)</td>
</tr>
</tbody>
</table>

When using the -alt option, use the -ref option in order to supply an appropriate reference ECG (Refer below).

**STARTING ECGSIM WITH AN ALTERNATIVE REFERENCE ECG**

In order to start ECGSIM with an alternative reference ECG, the file name of the reference ecg must be specified in the command line in the following way:

```bash
ecgsim -ref ReferenceFile
```

ReferenceFile is the name of the file containing the reference ECG. Its format is the standard matrix format (as used by ECGSIM in saving surface potentials). Each row represents the ECG as a function of time at the corresponding vertex of the thorax. Consequently, the number of rows must match the number of vertices of the thorax.
In the Windows version, the -alt command line option must be included in a short-cut by which ECGSIM is started. For that purpose, right-click on the short-cut, and add the -alt option and its parameters to the command line (after ecgsim.exe).

**FORMAT OF "STANDARD LEADS" FILES**

A "Standard Leads" file must have the following format:

8

1 v(1)

2 v(2)

.

.

8 v(8)

v(1) to v(6) indicate the index of the vertex at the thorax at which v1 to v6 are located. v(7) indicates the vertex to which VR is assigned, and v(8) the vertex to which VL is assigned (usually the tip of the right and left shoulder respectively).

aVR and aVL are constructed by multiplying the potential at v(7) and v(8) by 1.5. aVF is constructed as follows: aVF = aVR - aVL (this assumes the transfer matrix is referenced to Wilson Central Terminal).

The potential at lead I is constructed by taking the potential at v(8) minus the one at v(7). Leads II and III are constructed in a similar fashion.

**5.12 CONCLUSION**

ECGSIM is an interacting simulation programme that enables to study the relationship between the electrical activity of the ventricular myocardium and the resulting potential on the thorax. It offers following features:

- The size and position of the ECGSIM window is retained between sessions.
• The user can specify alternative heart and torso geometry;

• Activation patterns can be generated by defining foci at the epicardium;

• More Display options in the thorax pane: heart, lungs, and thorax can be hidden, made transparent or opaque.

• More Display options in the heart pane: left artery descends (LAD) and range of selection can be visualized.

• Transmembrane potentials and epicardial potentials can be mapped in the heart pane;

• Electrograms can be displayed in the membrane pane.

• The heart vector and vector loop can be plotted in the heart and thorax panes;

• The slope of the repolarization phase of the transmembrane potential can be changed;

• Different temporal filtering options are available for the simulated ECGs;